
Welcome to the Desktop Server 4 tutorial. Here we'll show you how to download 
and install the program, and get it setup and running. If you haven't purchased 
yet and trying the demo version, you'll be limited to sending 10 emails at a time 
instead of an unlimited number in the full version. All other features and options 
are available in the demo version. 
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 Installation 

The first step to using Desktop Server 4 is to download it to your computer. This 
will download the installer program (the file that installs Desktop Server as a 
Windows program) on to your computer. To begin: 

Use this link http://www.mtisoftware.com/download/dsiv.exe to download it, and 
if your browser asks if you want to save or open the file, choose "save". Before it 
starts, it will ask you where you want to save the file. If using Internet Explorer, 
this is what it will look like below. 

 

 In the top of the window you'll see a "Save In" and a box next to it. Click one 
time on the box and select "My Documents". This is where your web browser will 
put the install program when it's done downloading. This is the box, pictured 
below. Click the box one time to open it, then select "My Documents" from that 
menu.  



 
This is an example screen your menu will appear slightly different. 

When it's complete, click on the "My Documents" icon on your desktop. Your 
desktop is your computer screen where all your icons are. This is what you see 
when no programs are running on the screen. Usually, the "My Documents" icon 
is in the upper left side of your screen. Double click (click twice fast when the 
cursor is over it) "My Documents" and it will open. Then look for the file named 
DSIV and double click on that. It will start the installation process. Just click next 
for each window, don't change the default settings and wait for it to complete.  



 

 Unlocking Registered Version 

 

If you've already purchased, unlocking the full version of the demo you 
downloaded is quick and easy. First hit the "help" menu and choose "unlock full 
version". Enter the name your package was purchased under (usually the credit 
card holder name) and email address it was sent to. If you are copying and 
pasting the serial number, be sure to back out any extra spaces at the end so 
the cursor is right next to the final digit. It can cause unlock failure if there is a 
blank space. If you use a proxy server, enter the information in that box, your 
network administrator will have the settings you need to enter if you have one. 
Each unlock code will work on one computer. If you ever need to reinstall the 
program on a different computer, just email us your unlock code and request 
that it be reactivated.  

Settings and options  

When Desktop Server 4 starts, this is the main menu. From here you'll want to 
get it set up first. Select the "Tools" menu at the top, the select "settings". This 
will bring up the screen below: 



 

On this screen, enter the name and the email address you wish to use. This can 
be your name or company name. The email address can be any email account 
you have.     Do not change the maximum active connections unless 
instructed to by technical support. 15 connections is the default and it's 
plenty for most users. 
   

        Modem connections, Cable modems, and DSL will do just fine with a setting 
of 15. Setting this too high will cause your line to become saturated and 
performance will be degraded.  If you have a real T1 line or better then a higher 
setting may increase performance if you also have a fast system. For example, 
with a clear T1 I've seen customers set this as high as 50 with good results. A 
cable modem or DSL connection are not anywhere near as fast as a T1 
connection when it comes to upload speed, do not set it higher than 
15!  
The number one reason we get calls at tech support is someone who is having 
performance problems or lockups in the middle of a mailing, and it almost always 
turns out they set the connections to 100 thinking it will be faster than 15. 



Please heed our advice and keep it at 15 unless you have a true T1 or better 
connection.   

Next, hit the "advanced" button and select these options: 

 

Enter a name for your mail server. It can be anything you like but it must be a 
short word with no special characters. If you don’t know what to put in, 
just enter “email” for the name. This is just for some mail servers that look for 
an identifying name when they are contacted. I cannot stress again that it must 
be a short word with no special characters, DO NOT put in an email address or 
anything with special characters or it will cause problems.  



 If you often send to the same list, or your lists don't need cleaning, then 
uncheck the "clean list automatically" box for faster load times. A timeout of 15 
is plenty for most people. If you are mailing to a lot of overseas addresses, you 
may want to increase this to 20 or 30. Do not lower this below 15 or you may 
get a low rate of delivered mail. During peak times it may take 5-15 seconds for 
an email delivery to complete on one of your connections. 

Make your message 

Next, lets enter a message. You have three different choices to make a message. 
First you can make a text message, this will just be plain text, no photos, colors, 
or fonts.  
 
Next you can make an html message, or a web page that will be sent to the 
person as the body of the message so they see it right away when looking at 
their mail. With this you can have colors, fonts, ect. with about anything you 
could put into a normal web page. Third, you can load a web page that you've 
made already with another program already. 



 

Lets go over how to make a new message, since that's what most people will do 
first. Go up to the top and open the Message menu. Select "New message 
using..." and then choose WYSIWIG Editor (means what you see is what you 
get). The message editor will pop up. Now, decide if you just want a plain text 
message, or if you want a colorful html message. If you want html, then go to 
the Format menu and choose HTML.   
 
If you have an html document already here is how to load it: 
 
To load a web page you have made already, go to the message menu and select 
“new message using source editor” and then when the message editor pops up, 
select the file menu and then “import html” to load your html document.  

The Subject box is the subject line of your message, or the title. Enter this and 
go to the larger message box. Here you can compose your message, and 
customize it with colors and other changes. When you're done, in the message 
editor window, go to File then Save to save your message. Then finally close the 



message editor program. This message will be your default when you open the 
program in the future. 
        You can make and save as many different messages as you like. Now, you 
can drag and drop images into your message, and Desktop Server will send a 
copy of the images to each person on the list. This is called an inline image, 
where it's actually stored inside your message. One word of warning, if you're 
going to send several large images, this will slow down your sending speed 
dramatically of course. If you need to maximize speed for large mailings, follow 
the instructions below on how to send hot linked images using a third party html 
editor. If not, then skip the section below.  

How do I send my email as a web page with hot-linked pictures? 

If you plan on sending a large number of html emails, instead of sending inline 
images (like when you use Desktop Servers built in editor where each person 
actually gets a copy of the images) you'll want to put them on a web server and 
hotlink to them instead. This way they only get a link to the image, which 
appears when they view the email, and it downloads from your web server. This 
is much faster since you don't have to actually email the image file to each 
person. 

 HTML is the file format used by web pages, and you can use it for your emails 
with certain restrictions. Sending a web page as an email is different than just 
plopping it on a web server, here's how it differs.  

When view a web page, the images on it are usually contained on the web site, 
so they display properly and download into your browser when you bring up a 
page. Sending that same page through email is different, the person who gets 
the email won't have a copy of the images on their computer, and html or htm 
files don't support embedding images into them like say, a Word document does. 
A web page is just actually text if you look at it in an editor like notepad, it's 
called hypertext markup language and is basically just a bunch of instructions as 
to how the page should look (colors, fonts, ect.).  

The good news is it's relatively easy to change a web page so you can email it 
and have the images show up, it's similar to the way Ebay auctions are done. 
They don't store your image (unless you pay extra), you have to hotlink to the 
image somewhere on the Internet. Here's an example: 

If you have a web page, and there's an image in it called myimage.jpg, that file 
is on your web site, so just putting the name into your page is good enough, it 
can be found and displayed normally since the file is right there. If I send you an 
email, your email program won't have that image on your computer (you can't 
attach it either because different email program put attachments in different 



locations, you'd have no way of knowing where it would be on their computer 
when they got it). So instead of myimage.jpg you would go into your web page 
editing program and change the properties (usually by right clicking it and 
selecting properties, but this may vary depending on the program). If your web 
site was http://mydomain.com and that's where your image is located on the 
Internet, you would change the image properties to 
http://mydomain.com/myimage.jpg so when I send you the email with the 
picture, your email program would know where the image was located, and 
automatically display it. 

If you're new to making web pages, the best editor is Netscape Composer. It's 
very easy to use and free. Just go to netscape.com and download the Netscape 
browser. You never have to use the browser, just use the Composer program 
that comes with it. It's as easy to use as WordPad, very simple. I would not 
recommend using Microsoft Word or FrontPage to make an web page for 
sending via email. They are overkill and the files they make are much larger than 
they need to be. Your mailing will go faster if you keep it simple and stick with 
Netscape Composer. 

If you just read all this and saying to yourself "What did he just say?" then it 
would be best to have a professional make your html email for you. I 
recommend Stellar Design as they are affordable and very experienced. You can 
call them at 904-997-1970 and ask for Milt. If it's going to take you weeks to 
learn web page design and they can do it for you in a day for a reasonable price, 
it's often well worth having a professional do it, then you can learn to edit it and 
use the message as a template for future mailings. 

 

 

Loading your mailing list 

This is very simple, but you'll need to know where your mailing lists are located 
on your computer. Go to the Address List menu and select "import". You can also 
do this from the Files menu as well.  



 

This box will pop up, asking where your mailing lists are. If you harvest your own 
lists, I'd recommend saving them all to "My Documents" so you can find them 
easily no matter what program you're using. The file formats that Desktop Server 
can use are either regular one email address per line in a text file, or comma 
delimited (email address, a comma, then the persons name).  

Here is a sample of regular text with one address per line: 

joe1@email.com 
jerry@email.com 
 
Here is a sample of comma delimited, which is needed for personalizing a 
message, like inserting a persons name into the body of the message. You must 
have a list like this to use the personalization feature, it must have the name and 
email address to do it. 

joe1@email.com,joe smith 
jerry@email.com,jerry smith 

  



Managing your remove list 
 

 

The remove list is a list of email addresses that Desktop Server will clean, or 
remove from any mailing list that you load and then use the "clean" function on. 
You can have several different ones, for different projects. This works the same 
way, just import to load your remove list, and export to save it to disk (like after 
you make changes to it or add addresses).  

 

 

 

 

 



The mailing wizard 

 This makes mailings very easy, simply click on "Wizard" in the upper left area of 
Desktop Server and it will walk you through each mailing, just select the 
message and list. It's recommended that you use this after getting the program 
setup and tested. 

 

  

 

 

 

 

 

 

 

 

 



How Does Desktop Server work? 

First off, some explanation and background of how the program works. Desktop 
Server sends mail as an SMTP (Simple Mail Transport Protocol) mail server from 
your computer, much like the mail server used at your Internet provider. When 
sending mail with a client like Outlook or Eudora, the program sends the job to 
your Internet Providers mail server, which processes the job and reports back to 
you if there are any errors. 

     Needless to say, when sending mail in large quantities, this can degrade the 
performance of any ISP mail server, or even crash it during peak times with large 
lists. Internet providers are not happy when you load a list of 100,000 addresses 
and dump it into their mail servers, bogging down traffic for the other users and 
causing delays. They also keep server log files so they know who you sent to and 
when, a leading cause of accounts to be deactivated when doing bulk mails. 
Also, some ISP's put in "batch limits" on their servers on the amount you can 
send out at one time, sometimes as low as 25 or 50 before you can send more.  

    The alternative to this is sending mail with Desktop Server, which has your 
computer do all the processing and delivery. The only thing your ISP "sees" is 
that you're sending data out across the Internet. Your computer resources are 
being used, and the only thing you're using from your ISP connection is the 
bandwidth you paid for.  

 If you're mailing to joe@mydomain.com Desktop Server looks up where 
mydomain.com is, then contacts the mail server and asks if there is an account 
named "Joe" there. If so, it attempts to deliver the message and receives either 
a success or failure message (it would get a failure message if the persons 
mailbox was full, for example).  
         Desktop Server delivers the mail to those in your address list individually, 
so each person gets their email address in the To: field of the message, and 
whatever return address you specify.  

   What kind of speeds can you expect? 5,000 to 8,000 per hour on a typical 56k 
modem connection are average. With cable or DSL the speeds can go 2-15 times 
higher depending on traffic conditions and the list being sent to (overseas lists 
are typically slower than ones in your home country of course). The key factors 
are the size of the message, if you have any attached or inline files, the upload 
speed available to your connection, and the speed which your ISP's DNS server 
responds. The list itself will also affect the speed, a poor quality list with a lot of 
invalid domains will slow you down compared to a good list. Remember, the laws 
of physics applies to sending email :) If you send an email with a 300k 
attachment using a modem connection, you're going to get much worse speed 
than if you were sending a message only 3k in size!  



  

Troubleshooting and Performance Guide 

If you're having difficulty, be sure to read through the sections below. There are 
easy answers to many common problems. 

Desktop Server is only showing a few emails in the "sent address" 
section. 

Desktop Server adds an email address to the sent address list only when it gets 
back a positive confirmation message (at the time it's trying to deliver that email) 
that the email was recieved and delivered to the users mailbox by the recipients 
mail server (called a POP server, used to process incoming mail).  

Most ISP's don't accept emails "live" anymore since if they got a big burst of 
mail, they would lose messages if they couldn't process them fast enough. Most 
only return a "message cued" since they will process it at a later time (maybe 
minutes later, sometimes as long as hours if they are really busy). This response 
doesn't count as sent, because Desktop Server has no way to know if the email 
arrives or not, or even if it's a valid address until it gets processed later. 

If you are sending say, 50 emails and only a small portion show in the "sent 
address" list, it's because most of them went to ISP's that process their incoming 
mail later, which is a common practice today.  

Desktop Server isn't sending email, when I send a test mail to myself it 
doesn't get there. 

 The first thing you should do is check to see if port 25 is available on your 
Internet provider. This is the port that all mail servers need to send on. On the 
Internet, ports are similar to channels on a TV set, it's expected that mail servers 
will send on port 25, and that's what port other mail servers are listening to be 
contacted at, so you cannot send on any other port number.  

If none of your test email is getting out, follow these steps. Also if you're sending 
test messages and they are only arriving at a mailbox that's at the ISP you're 
connected to, but not to the outside world. 

 

 



First, download our port 25 test program to see if it's available on your Internet 
connection. Download it here at http://mtihelp.com/demos/port25test.exe 
 
 

 Select save to disk, and save it to your desktop. Make sure you close all other 
programs before running the test. When the download is completed, double click 
on the program to run it while connected to the Internet. If it does not say port 
25 is enabled, then your ISP is blocking it. Only run it one time, the first 
result is the only accurate one. Some do and other don't so you should ask if 
they block any ports when signing up with an ISP. If you send a blank email to 
sales@mtisoftware.com with the word “port25” in the subject line we will send 
you back a list of current ISP’s that allow port 25 access. 
If port 25 tests out ok, then I would close all other programs running on the 
taskbar to try narrowing down the problem. The taskbar is the gray bar at the 
bottom of your screen (pictured below).  

 

The icons on the taskbar and on the right side of it are all running programs. It's 
important to close, not disable as many as possible just to narrow down what 



might be causing the problem. When you restart the computer, all of them will 
go back to the way they were. Do not disable, you have to really close them or 
they will continue to run. You can usually close them by moving the mouse over 
the icon, then right click and a menu with "close" or "exit" should allow you to 
close them. If you don't use Microsoft Task Scheduler, double click the icon to 
bring it up, go to the Advanced menu, then select "stop using task scheduler" to 
turn it off.  

If there are a lot of programs on the taskbar that you cannot get to close, you 
can turn them all off this way. Go to the start button on the taskbar, select Run, 
then type in the box msconfig and hit Ok. 

 

It will start the msconfig program, select the tab that says "startup" 



 

Simply uncheck all the boxes and then reboot, it will start windows "clean" or 
without any of those programs loading themselves onto the taskbar. This is a 
great way to troubleshoot a program if you suspect another program on the 
taskbar is conflicting with it. To restore your system to the way it was, just run 
the program again and check all the boxes, then restart the system.  

  

Only some of my mailings are getting sent 

If you're having that problem, check these settings. 



 

First, go to the Tools menu and select "settings" which will bring up this screen. 
It's possible your DNS server may not be detected correctly. Uncheck the 
"automatically discover domain name server" and call your ISP technical support. 
Ask them for the primary DNS number and compare it to see if the number was 
detected correctly. If it's different, enter the number they give you in the box. 
You will have to restart the program for the settings to take effect.  

Also check "Maximum Active Connections" to make sure it is set to 15. Setting it 
too high can cause your line to get saturated and timeouts to occur on some of 
the mailing. Also click on the "advanced" button and make sure a name is 
entered for Desktop Server. It can be any name you like, but it is important to 
put something (anything) in there. 

Desktop Server locks up or crashes during a mailing 

If you have closed any unneeded programs on the taskbar and Desktop Server is 
crashing or locking up after a certain amount of time, check the following. Turn 
off any screen savers or power management options. To turn off any 



screensavers, right click over a blank spot on your desktop (your computer 
screen) and select Properties. Then select the screensaver tab and select "None" 
for the screensaver. This will keep it from coming on. Please know there is no 
way to "burn in" a modern CRT color monitor, that was just a problem with older 
monochrome monitors from years ago. Screensavers may look fun, but they use 
a lot of CPU processing power and accomplish nothing. Also if you have a 
program running like Desktop Server, and it's working away when a complex 
screensaver starts kicking in, it can seriously degrade your mailing and can even 
crash some programs.  

The other thing to turn off when using programs that run unattended for hours 
like Desktop Server is power management. For Windows 95/98 users, click on 
"My Computer" then "Control Panel" and you'll see "Power Options". For XP users 
you can hit the start menu button, select "Settings" then "Control Panel", then 
open Power Options. No matter which version of Windows you use, you want to 
turn power options to "never" so it never tries to put your system to sleep. If you 
have a Notebook computer, then you can select the different themes as needed. 
When Desktop Server loads a list into memory, it does a mailing and does not 
need to access the hard disk anymore. As you can imagine, if you have a mailing 
that takes 2 hours and your power management is set to put your system into 
sleep mode if the hard drive isn't accessed for 30 minutes, it's going to crash 
Desktop Server since it wants to keep running. 

A note on firewalls and anti-virus programs 

Some firewalls and anti-virus programs can be very intrusive and interfere with 
or cause slowdowns to other Internet programs like Desktop Server. With the 
amount of hacking and viruses out these days, I would never recommend 
running a computer (especially with a fast Internet connection) without both 
installed. Instead of going over all the ones on the market, I'll share with you our 
picks. These are the ones we actually use and we highly recommend them for 
their compatibility and performance.  

For an Antivirus I recommend Norton Antivirus. This program has been around 
for years and works great. It's affordable and easy to keep updated. However, 
we don't let it run in autoprotect mode, which basically scans all traffic on your 
computer and slows performance. We have that option turned off, and just run 
an virus scan whenever needed. You can get it online at symantec.com or most 
any retail computer store. 

For software firewalls, we recommend Zonealarm. It's available free at 
zonealarm.com and if you check security web site reviews, you'll find it's one of 
(if not the) top rated firewalls out there. Performance and compatibility is 
excellent and you can keep it running while using any of our products. If you 



have a network and a hardware firewall installed, contact your network 
administrator. Desktop Server needs port 25 outgoing to send mail, and uses 
port 80 outgoing for the unlock code.  

Desktop Server IV does not return with a success box when registering 
and shows “invalid serial number” when I hit Help menu and “About”. 

If you are trying to unlock DS4 and getting no success box, and if you select the 
"help" menu and "about" and it says "serial number is invalid" just follow these 
steps to correct the problem: 

On your desktop double click My Computer 
Double click Control Panel 
Double click Add/remove programs 
Select Desktop Server and remove it (if it's in there multiple times remove them 
all) 

The remove the Desktop Server folder that's left over by doing this: 
On your desktop double click My Computer 
Double click C: drive 
Double click program files 
Double click MTI 

You will see a desktop server yellow folder, single click on it to highlight it and hit 
the delete key, 

Then simply install the demo version and go to help menu and pick "unlock full 
version" and it will register correctly. You should get a confirmation box saying 
your product is now registered.  


